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Introduction 
 
This Job Aid provides a detailed overview of the CONNECTIONS system changes and 
enhancements introduced for Quarter 2, 2009 (Q2-09). This Build is being implemented on 
Saturday June 27, 2009.  The Job Aid is intended for CONNECTIONS users on different 
levels, and assumes familiarity with the CONNECTIONS System. As is true for all 
CONNECTIONS implementation reference materials, this Job Aid is available online on the 
CONNECTIONS intranet site: 
 

http://ocfs.state.nyenet/connect/jobaides.asp. 
 
Improvements to CONNECTIONS that are implemented periodically through SIRs and 
Change Requests are referred to as "Builds." Since these improvements are implemented on a 
quarterly basis, they are also being called Quarterly Improvement Plans and are referred to this 
year as Q1-09, Q2-09, Q3-09 and Q4-09. The Q1, 2, 3, or 4 indicates the quarter of the year 
beginning in January and "09" represents 2009.  
 
With the implementation of Q2-09, several changes will be introduced aimed at improving the 
worker satisfaction and system ease of use. It should be noted that many of the enhancements 
included in this Build originated from user requests, and issues identified through the 
CONNECTIONS Triage Unit ‘app help’ mailbox and the Helpdesk. 
 
Specifically, this Job Aid contains information about enhancements in the areas below.  Please 
note that any visible identifying data in this Job Aid is simulated.  
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I. Update Placement Information (Location Detail Window) 
 (SIR 9158) 
 
Q2-09 includes system enhancements to assist workers in reviewing and updating placement 
information in CONNECTIONS. A new window, Location Detail, has been added, navigation 
has been improved, and improvements have been made in system messaging.  
 
Prior to Q2-09, child placement information, retrieved from CCRS and displayed in 
CONNECTIONS, could only be updated and saved in the FASP.  Placement details carried 
over to CONNECTIONS from CCRS for display only in Tracked Child Detail on the 
Placement Information tab.  From the FASP Location of Child tab, CCRS information could 
be saved as is within the FASP or edited. However, information updated in the FASP would 
not display in Tracked Child Detail on the Placement Information tab. 
 
The Location Detail window has been created to allow workers to view CCRS and 
CONNECTIONS information side by side and modify placement details in CONNECTIONS, 
from both Tracked Child Detail and the FASP, as needed. It is very important to note that if 
any such change is made in CONNECTIONS it must also be made in CCRS movement 
activities, as CCRS remains the system of record for placement of foster children and 
CONNECTIONS changes do not carry over to CCRS.  
  
Accessing Location Detail from Tracked Child Detail 
To view or update placement information on the Placement Information tab on Tracked Child 
Detail, the user selects a child from the grid. CCRS/CONNECTIONS placement information 
will display and the View/Edit push button will enable. The worker may see a message 
“Alternate Information Exists in CONNECTIONS” next to the push button. This message 
alerts workers when placement information, other than that which is obtained from CCRS, is 
available.  This information may have been from a previous FASP, an In-Process FASP, or 
has been recorded through Tracked Child Detail on the Location Detail window.  Clicking on 
the View/Edit push button will open the Location Detail Window. 
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The Location Detail window has a split screen presentation. On one side is CCRS information, 
and the other side is labeled “CONNECTIONS Information.” On the CCRS side, the “Most 
Recent Activity.” field will display the most recently recorded CCRS placement (movement) 
activity such as: Child Ends Absence, Intra-Agency Transfer, etc. to further clarify the child’s 
placement status. The child’s location can be updated on the CONNECTIONS Information 
side of the screen.  
 

 
 
When the window is saved, the worker is given a choice whether to save the changes to the 
current In Process FASP.  If the worker selects “Yes”, changes will be saved to the current 
FASP, Appropriateness of Placement, “Location of Child” tab or Plan Amendment, “Location 
of Child” tab.  If “No” is selected, the FASP or Plan Amendment will not be updated.  
 
 

 
 
 
Delete Information Push Button 
When the Location Detail window is accessed via the Tracked Child Detail path, a “Delete 
Info” push button will be available on the window. Selection of this button will remove all 
CONNECTIONS placement information that has been entered on that window only.  
CONNECTIONS information on the Location Detail window of the FASP or Plan 
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Amendment will not be deleted. The windows in the FASP or Plan Amendment are accessed 
separately to change information, as necessary.  
 

 
 
 
Accessing Location Detail from the FASP  
To view or update placement information from the Location of Child tab in the FASP, or a 
Plan Amendment, select a child from the grid. If placement information exists in either CCRS 
or CONNECTIONS, that information will be displayed in the corresponding CCRS or 
CONNECTIONS grid.  Radio buttons will allow the worker to select either CCRS Placement 
Data or CONNECTIONS Placement Data to be utilized in the FASP, or alternatively, 
selecting Edit will bring up the Location Detail window where CONNECTONS information 
can be added/updated. 
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If the worker clicks on the Radio Buttons when no data exists in the grids, the following 
message will display:  
 

 
 
 
Once the worker selects either the CCRS or CONNECTIONS data and saves it, only that data 
will display on the Location of Child tab, with appropriate questions to be answered displayed 
in boxes below.  If, at a later time, additional location updates are necessary, the Location 
Detail window can be accessed via the “Edit” push button.  Please note that changes made in 
this manner update location information in the FASP or Plan Amendment only, and do not 
carry over to Tracked Child Detail.    
 

 
 
Regardless of whether location detail is saved to the FASP, changes made on the Location 
Detail window will not overwrite information in CCRS. CCRS information must be updated 
separately. 
 
 
II.  Family Assessment and Service Plan  
Modify Original Reason for Case Opening (SIR 9152) 
Workers and supervisors have requested improvements in the manner in which case opening 
information is initially recorded, and updated, in the FASP. In Q2-09, for the first FASP in the 
FSS Stage, the Original Reason for Case Opening tab will be recorded as one continuous 
narrative. After the initial information is approved, addendums can be added on subsequent 
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FASPs (Comprehensive and Reassessments) by the Case Manager or Case Planner. All 
addendums will include a date and signature stamp. 
 
Scales/Risk Pre-Fill to Service Plan O&A Blocks (SIR 9137) 
With Q2-09, the CONNECTIONS system will support the ability to pre-fill the 
“Problem/Concern” component of the Service Plan O&A blocks from Family, Child or 
Parent/Caretaker scales, and from Risk Assessment-Elevated Risk questions in an in-process 
FASP.  To accomplish this, a new column “Create O&A Block for Scale” has been added to 
the Scales and the Elevated Risk window. 
 
On the Family, Child, or Parent/Caretaker Scale window, clicking in the “Create O&A Block 
for Scale” column will display a drop down arrow.  Selecting “Yes” from the drop down will 
result in a “Yes” appearing in the first section of the scale response.  When the scale is saved,  
a “Temp” O&A block will be created.  O&A blocks created in this manner will include ratings 
for all individuals recorded in the scales. 

 
 
On the Elevated Risk Elements window, an O&A block can be created by selecting the Create 
O& A Block checkbox and selecting “OK”.   A “Temp” O&A block will be created for each 
applicable elevated risk element when the Risk Assessment is saved. 
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On the O&A block index, a “Problems/Concerns” column has been added to the grid. The first 
100 characters from the identified scales response or elevated risk question will pre-fill to this 
column.  The identified issue and language that is carried over from the scales can be used as a 
starting point for developing the problem/concern statement that reflects a family’s specific 
needs and circumstances.  All O&A blocks created in this manner will have a temporary 
(“Temp”) status.  
 
A “Delete” push button has also been added to the O&A block index window. This will allow 
the worker to delete any O&A block with at “Temp” or “New” Status.  The “Delete” button 
will enable when the O&A block is selected. Deleting an O& A block will clear the 
corresponding “Yes” indicator on the FASP scale or Elevated Risk window. 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
In order to carry over an O&A block upon approval of the FASP, the status must be changed 
from “Temp” to “New.”  This is accomplished by accessing the O&A Block Detail window, 
adding information necessary to complete the O&A block, and saving the window. To support 
this process, when a FASP is submitted that contains “Temp” O&A blocks, a message will 
display on Check FASP Detail: O&A Blocks of Temp status exist. These blocks will not be 
carried forward to subsequent FASPs unless changed to ‘New’ status. 
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Upon approval of the FASP, any “Temp” O&A blocks and “Create O&A Block” checkboxes 
will be deleted and not carried forward to the next FASP.  If a FASP is rejected by supervisor 
(i.e. not approved) any Temp O&A blocks will be viewable to the worker.  O & A blocks in 
“Temp” status will not display on the FASP Component Report, O&A Block Report or the 
Full FASP Report. 
 
Assessment Scales (SIR 9143/9171) 
Q2-09 includes two changes in the FASP assessment scales. The first modification will allow 
local districts to opt out of completing some assessment scales.  Secondly, workers will be 
able to utilize a multi-select option when answering age-based questions in the FASP, even if 
all children listed do not fall within specified age limits.  
 

       1.  Optional Scales 
Full and thorough assessments of family strengths and needs continue to be an important 
casework requirement and should be completed with every family. If a district elects to lift the 
edits requiring the completion of the scales, the caseworker will record only information that is 
a particular strength or need for the family or individual. For example, if one child is assessed 
as having a 'debilitating illness', but three other siblings have no medical issues, the caseworker 
can choose to only record information about that one child on the scales.  

 
If a district decides to make FASP scales optional, all scales will be presented in the FASP, but 
for cases with a protective program choice, the system will only require completion of the 
assessment scales that are mapped to the RAP.  It becomes a district option to require that 
scales be completed in given circumstances. The following assessment scales will remain 
required, and others may be completed optionally.  
 
- Family Scales: Questions # 1, 2 and 4 
- Parent/Caretaker Scales: Questions # 2, 4, 7, 8, 9, 10, 13 and 18 
 
An identifier "Mapped to RAP" has been added to the end of each required/mapped scale 
question to distinguish it from other questions. This indicator will not be displayed in output 
reports. Districts that do not opt to lift the edit on scales, and consequently require all scales, 
will see no changes.  
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  Impact on Reports
  The FASP Reports will display all available questions and responses, including questions that 

have not been answered, regardless of whether a district opts to make scales optional, i.e. not 
system required. When no questions have been addressed for Child Scales, a blank section will 
be displayed in the Assessment Summary report. 
 
Impact on the FASP Tree 
For districts that opt to make scales optional:  

o If there is a protective program choice, the “Required” indicator will display until 
the required Family and Parent/Caretaker scales are completed. 

o The 'Required' indicator will be removed from the FASP tree for Child scales for all 
FASPs. 

o The 'Required' indicator will be removed from the FASP tree for Parent/Caretaker 
Scales for an Initial FASP. 

 
Implementation Considerations  
Districts that would like to lift system edits requiring all FASP scales must advise 
CONNECTION Regional Implementation staff of this request. 
 

2. Multi Select for Age Specific FASP Questions  
When the "All" column is selected for a scale that has an age restriction (e.g.  Academic 
Performance - Children age 6 or over), the system will now select the checkboxes for children 
within the specific range, and leave blank those children who are out of range.  
 
Needed Improvements/Changes Tab (SIR 9154) 
In response to users’ requests to streamline the FASP, the “Needed Improvements/Changes” 
tab on the Family Assessment/Analysis dialogue has been removed.  Users have stated that 
information recorded on this tab duplicates information recorded in the Outcome and Activity 
Blocks in the Service Plan.   
 
Prior to Q2-09, the "Needed Improvements/Changes" tab in the FASP was used to record the 
conclusion reached from the analysis of all the assessment information gathered.  Now, this 
information about what needs to improve or change will be recorded in the Service Plan. 
 
By retaining the other tabs in the FASP, workers are still able to record information regarding 
the Family View, Behaviors/Contributing Factors, and Strengths that are intended to 
supplement the assessment information captured in the Scales, Safety Assessment and RAP.  
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Please note that for FASPs that have data entered in the Needed Improvements and Changes 
tab prior to Q2-09, the tab will continue to display. Information will also continue to print on 
FASP reports.  
 
FASP/PHR Mapping (SIR 9646) 
Caseworkers completing both the FASP and PHR are required to answer similar questions 
with very similar statements. This enhancement will assist workers to develop answers to PHR 
questions that are consistent with the corresponding/mapped FASP question when pre-filling 
from the FASP to the PHR. 
 

 

II.  
emove Well-Child Diagnosis
ith implementation Q2-09 diagnosis of “well-child” will no longer pre-fill from the Health 
odule in CONNECTIONS to the Permanency Hearing Report.  This pre-fill to questions #21 

nd 23 of the Individual C r Multiple Child Report and questions #23 and 25 of 
e Freed Ch ing misleading in the context of the PHR. 
 

dded Options when launching a prefilled PHR (SIR 9650) 
rior to Q2-09, the ability to pre-fill from a FASP to the PHR was limited to approved

A pushbutton, PHR Question, has been added to tabs on the FASP that include questions that 
carry over to the PHR.  Clicking on the push button will open a window that displays the 
FASP question, associated PHR question, and any conditions associated with a pre-fill from 

ASP to PHR.  F
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
I Permanency Hearing Report 
R  Pre-fill (SIR 9647) 
W
M
a hild Report o
th ild Report was identified as be
  
 
A
P  FASP’s 

ted more flexibility in the pre-fill options, so now 
 In-Process/Pending FASP. This 

will allow the most recently recorded case information to be pre-filled from FASP to PHR.  If 
no in-process or pending FASP exists, the system will display a message stating that the PHR 

only. CONNECTIONS users have reques
workers will be able to select from an Approved FASP or an
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Placem
however, th ent location 
question in 
process  and Type will be 
retrieved ent to 

• 
• Multip
• 
If no inf e 
lank, and must be manually entered by the worker. 

 
 
 

will pre-fill from the last approved FASP.  Workers also continue to have the option of 
selecting No Pre-fill.  
 

 

PHR Placement Information Pre-Fill (SIR 9671)  
ent information is displayed in a FASP from an interface with CCRS. Prior to Q2-09, 

at placement information has not been used to pre-fill the placem
PHR. Now, placement information stored in the latest approved, pending or in-

 FASP will be used to pre-fill this PHR question.  Facility Name
 once saved in the FASP, Location Detail in Appropriateness of Placem

populate the following PHR questions:  
Individual Child PHR – Question #15 

le Child PHR – Question #15 
Freed Child PHR – Question #17 

ormation has been saved in the FASP, the corresponding fields in the PHR will b
b
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odifications in the 
is effort, the 

narrative comment boxes were rede tered if “No 
Safety Factors Present” was chosen.  Som
support local supervisory ced In response, 
Q2-09 will include an optional comment box that ty Factors 
window when “No Safety Fact
 

 

V. 
W
the system

extended periods, m nage. Alerts or 
Remi ed time periods 
as follows: 

- 
- 
- 
- 

- FSI  
- 

 

IV. Safety Assessment 
Safety Factors Comment Box (SIR 9539) 
CONNECTIONS Build 18.10, implemented on 10/10/2008, included m
Safety Assessment to improve and streamline the assessment tool. As part of th

signed and no narrative was able to be en
e local districts have since requested that, in order to 

practices and procedures, this narrative be reintrodu
will be available from the Safe

ors Present” is selected. 

 
  Time Limit To-Do Display (SIR 9136) 
ith Q2-09, Alert, Reminder, and non-navigable Task To-Do’s will no longer be displayed by 

 after a specified period of time, as indicated in the list below. This change will 
address the situation in which To-Do’s were remaining on the worker’s To-Do List for 

aking the To-Do list cumbersome and difficult to ma
nders will remain on the Case To-Do List and Staff To-Do List for specifi

Display To-Dos for 30 Days: 
INT Stages 
INV Stages (including IAB) 
ARI Stages  
To-Do’s not associated with a Stage   

Display To-Dos for 90 Days: 

FSS stages 
Display To-Dos for 180 Days: 

- FAD stages 
Please note that no change has been made to navigable Task and Approval To-Do’s.  These 
To-Do’s will remain on the To-Do list until completion of the associated task. 
 



 

6/16/09 CONNECTIONS Q2-09 Job Aid 15 

 Collateral Contact (SIR 9147) 
 and retrieve information in Progress Notes regarding attempted 

C a quested a new progress note type “Attempted Collateral 
C a .  
 

 grid on the Progress Notes Detail window lists the name and 
PID for all individuals in the Stage.  If two (or more) family members have the same name, 

y for caseworkers to easily differentiate between individuals.  
een added to the grid to display current age.  

 

VII.  Case List 
This modif lts in CONNECTIONS 

ch results were not 
descending order by case 

 

a new PID is system
it may be ne tly created for 

 
W

 when the Adoption 
 edits will 

ontinue to prevent a pre-finalization PID from being merged with a post-finalization PID. 

VI.  Progress Notes 
Attempted
In order to more easily record

ont cts, Local Districts have re
ont ct.” This value has been added

Age Added to Participant/Focus Grid (SIR 9537)  
Th  F  Participant/Focuse amily

however, there has been no wa
An d mn has now b a ditional colu
  

 
Sort Order (SIR 9141) 

ication will make it easier for users to review search resu
when a Person search is done based on Person ID.  Prior to Q2-09, sear
displayed in a predictable order. Now, the Case List will be sorted in 
ID when the search is executed through either a person search or a person list path. 

VIII.  Person Merge on Finalized Adoption PIDS (SIR 7636) 
When the Adoption Finalization window is completed in CONNECTIONS    

 generated for the adopted child.  After this post-adoption PID is created, 
cessary to complete a person merge if yet another PID is inadverten

the adopted child.  Prior to Q2-09, the system would disallow this merge. 

ith Q2-09, a person merge can be performed on post-finalized adoption PIDs.  Edits will 
require the “person forward” be the PID that was initially assigned
Finalization window was completed in CONNECTIONS.  Please note that system
c
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ly need to 
reate or modify a Service Plan Review (SPR) without accessing the rest of the case.  Users 

 have been unable 
 Function (case 

.   Foster and Adoptive Home (FAD) 

 in 
ONNECTIONS in support of this regulation by requiring the recording of information 
garding the In-State SCR Database Check.  The edit will check for completion of “Sent 

arents, and will prevent opening of 

 
 
Please note that the new edit will also apply for homes that are worker or system-closed and 
are being reopened.  In order to reopen such homes the worker will need to record the SCR 
database check fields.  The following are acceptable sources of documentation to confirm the 
sent and received dates and results:   
 
1. Correspondence from the NYS SCR containing the actual dates and results.  (If the worker 

cannot find the sent date, they may use the received date for both.) 
 

2. If the worker is not able to find correspondence from the NYS SCR, it is permissible to 
obtain the dates and results if recorded in progress notes or the initial home study.   

IX.  Service Plan Review BF Access (SIR 7066) 
A special Business Function (BF) “ACC SERPLAN REV” exists for staff who on
c
with the “ACC SERPLAN REV” Business Function have reported that they
to access the SPR via the navigation path associated with the Business
search>case list>case summary> options>service plan review.)  This navigation problem has 
now been corrected.  
 
X
SCR Database Check (SIRS 9132/9150) 
New York State regulations require SCR database checks for all persons age 18 years or older 
in a foster boarding home or adoptive home before the home can be fully certified or 
approved.  An edit has been added on the FRS Household Member Detail window
C
re
Date” “Received Date” and “Results” for foster/adoptive p
a new FAD home unless these fields have been completed. Similar edits were implemented in 
March 2008 to support requirements for out-of-state child abuse and maltreatment checks.    
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e actual 

 

 

e-fill the 
perating “end date” with the date worker records the facility closing in CONNECTIONS.  

 
 
 
 
 
 
 
 

3. If there is reference made in a progress note or the initial home study that the check was 
completed and what the results were but no exact date sent and received, then it is 
permissible for the worker to use the entry date of the progress note or the approval date of 
the initial home study for both the sent and received dates and then record th
result.   

In the event that the worker is unable to locate any documentation that a SCR database 
check was sent and received along with the results of the check, the worker will need to 
obtain new SCR Database Checks on everyone 18 years old or older. System edits in 
CONNECTIONS will require that this information be recorded for foster/adoptive parents
before the home can be progressed to Accepted-Active status. 
 
 
Operating End Date Field (SIR 9597) 
A new field has been added on the FAD Close Home window.  This new field will address a 
limitation that has existed in CONNECTIONS whereby the system would pr
o
The new “Operating End Date” will better support proper reimbursements to facilities by 
allowing for the recording of an actual closing date, including a prior date. Even though the 
“Operating End Date” appears on all Close Home windows, it applies only to congregate care 
facilities.  The “Operating End Date” is entered as a part of the Close Home process. 
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Support Tools

 

 

ny window 
 

The 

 

 

jor 

 
How Do I? Step-by-step instructions to help you complete tasks using 

CONNECTIONS. 
 

Window 
Descriptions 

Descriptions of windows in CONNECTIONS, along with 
information on various fields. 
 

DSS Policy Online OCFS policy handbooks (under revision) 
 

On This 
Window 

Window description help for the window you are on. 
 

elp for Help Instructions on how to use the help functionality. 

our selection displays. In some cases, you will need to 
 selection in that window to obtain instructions. At the top of each 

itional buttons and menus. Use the Search button to search 
ck button to return to 
n opens a list of 

Print button allows you to print Help 
n. 

Online Help 

CONNECTIONS Online Help provides descriptions for various windows, as well as step-by-
step instructions for common tasks. You can access Online Help at any time, from a
in CONNECTIONS by clicking on the Help menu or pressing the F1 key on your keyboard. 

Contents, Index and Search tabs in Online Help allow you to search for and navigate to the 
topic(s) on which you need help. 

To Access Online Help: 

1. Click on the Help menu on the CONNECTIONS Toolbar. 
The following list of commands displays: 

Contents A table of contents for the help facility with links to ma
sections. 

Help 

H
 

About 
CONNECTIONS 

Information about the current CONNECTIONS version and 
build. 

2. Click on a command from the Help menu. 
The window related to y
make another
window you will see add
for specific information in the Help function and use the Ba
windows you have just visited in Help. The Glossary butto
important CONNECTIONS terms and the 
informatio
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3. When you are done reviewing information in Help, close each Help window by 

n the Closclicking o e button ( ) in the top right corner of the window.  The sy
w you were using when you accessed Help. 

stem 
windo

 
 

OCFS CONN ntrane
 
A variety of training-related materials are available from the OCFS CONNECTIONS intranet site 
(http://ocfs.sta related to 
various aspects of CONNECTIONS, including training schedules, Alerts and Notices, Step-by-
Step Guides ONN de), Job Aids 
and Frequent ons modifications, 
enhancements, fixes and impacts in the Build—is also available from the CONNECTIONS intranet 
site. 

Accessing the OCFS CONNECTIONS Intranet Site 

2. 

3. 
TIONS home page displays. 

. Click on a topic to access information. For access to various Step-by-Step Guides 
and Job Aids, click on the Step-by-Step/Job Aids/Tips link. For access to 
Quarterly Improvement Release Notes for Q2-09, click on the Implementation 

5. 

If you are an SSL VPN user, you can connect to the OCFS Intranet through a link on your OFT 

returns to the 

ECTIONS I t Site 

te.nyenet/connect/). The intranet site contains a wealth of information 

(including the C
ly Asked Questi

ECTIONS Case Management Step-By-Step Gui
(FAQs). Release Notes—a complete list of the 

1. From your local desktop, double-click on the Internet Explorer icon. 

If the browser does not display the OCFS intranet site automatically, enter 
http://ocfs.state.nyenet into the browser’s address line and press the Enter key on 
your keyboard. 
The OCFS intranet home page displays. 

Click on the CONNECTIONS link. 
The CONNEC

4

link. 

To close Internet Explorer, click on the File menu and select Close. 
 

Welcome page- http://ocfs.state.nyenet/
 

Enterprise Help Desk 
 
The New York State Office for Technology (NYS OFT) Enterprise Help Desk staff is available to 
answer basic questions related to your equipment or to solve problems you are having with the 
CONNECTIONS application. If they cannot solve your problem, they will record your information 
and forward it to others who can. 
Your agency may have procedures in place for contacting the Enterprise Help Desk. Check with 
your supervisor before you call. 
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The Enterprise Help Desk is staffed 24 hours a day, seven days a week. The telephone number is:  
1-800-NYS
 

When you call , you will be given a ticket number to use 
for trackin cord of this number; you will need it for any 
follow-up c v

App Help 
 
In addition to ctly 
contact the NYS CONNECTIONS User Support/Triage staff for help with complex application 
issues. Que
ocfs.sm.conn_app@ocfs.state.ny.us

-1323 (1-800-697-1323). 

 the Enterprise Help Desk with a problem
g your issue and its resolution. Keep a re
on ersations with the Enterprise Help Desk. 

Mailbox 

calling the Enterprise Help Desk with application issues, district staff can dire

stions, problems and concerns can now be emailed to:  

 
The ‘App Help’ mailbox is intended to provide an expanded level of support. It is meant for 
questions that have had an initial review by agency staff who are proficient in CONNECTIONS 

 For example, if you have an issue for which you have unsuccessfully 
 supervisor or a Resource User, it would be appropriate to contact the App 

 

(e.g., Resource Users).
sought advice from your
Help mailbox with the issue. However, your in-agency resources should always be your first 
contact when trying to resolve an issue. 

 


	 
	Online Help 
	Enterprise Help Desk 
	App Help Mailbox 

